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Getting Started 
 

Welcome 

Thank you for purchasing Minutes Matter Studio. You are about to encounter a design 
experience like never before! This visualization tool will eliminate costly communication 
errors and save valuable time during consultations. By using Studio your sales will 
dramatically increase! Your clients will have confidence in you, your ideas, your knowledge, 
and your professionalism. Studio is a powerful graphic software program which was 
developed solely for Interior Designers and Window Treatment Professionals. This stand-
alone program includes many features that are crucial to this industry. 
 

Studio Manual 
The manual provides descriptions of all the program tools, as well as step-by-step 
instructions and important tips for using every feature in the program. The clipart includes a 
sample of the various treatment styles that can be found inside the program. The clipart does 
not depict every image in the program. The Studio system/tutorial disk is located in the back 
of the manual. 
 

It is important to read “Getting Started” to learn more about installation and activation 
before installing Studio on your computer. 
 

Tech Support 
We have received rave reviews regarding our customer service and tech support. By utilizing 
our various support options, you can quickly assist your clients in visualizing their dreams! 
Please take time to view the entire Video Tutorial on the enclosed disk to maximize your 
design experience. This Tutorial will define important features and functions of Studio. 
During the conclusion, these features and functions will be utilized in a completed rendering. 
You will also benefit from Studio’s online forum, The Lounge and Studio’s Learning 
CD’s. Please take time to review these support options so you can make the most out of 
your Studio experience. 
 

Have fun designing! 
The Staff of Minutes Matter Studio 
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License Agreement 

Notice to User – Read Carefully  
This is a contract. Licensee acknowledges that it has read and understands this agreement 
and by opening, installing, and/or utilizing this software, you accept and will be bound by all 
the terms and conditions of this agreement with Minutes Matter Solutions, Inc. as set forth 
below. 
 
The term “Software” includes any and all upgrades, modifications, and versions of the digital 
or printed product licensed to you by Minutes Matter Solutions, Inc., also referred to as the 
“Licensor”. This copy of the Software is licensed to you as the purchaser, also referred to as 
the “Licensee” or “You”. The Licensor grants “You” a nonexclusive, non-transferable, 
limited right and license to install and use the Software, provided that “You” agree to the 
following: 
 
Single License Agreement  
Minutes Matter Studio is licensed to a single company who can install the product on two 
computers, e.g., one desktop and one laptop computer. Additional licenses/seats may be 
purchased for a single company at a corporate discount.  
 
Copyright and Use of Software  
The Software is owned by Licensor and is protected by United States Copyright Law, 
International Treaty provisions, and other laws. All title and copyrights in and to the 
Software (including without limitation, any designs, design elements, images, photographs, video, audio, and 
text), the accompanying media and printed materials and derivative works are owned by 
Minutes Matter Solutions, Inc. and are protected by copyright. Limited usage rights are 
granted to the Licensee. Unauthorized reproduction or distribution of this product, or any 
portion of it, in any form or by any means, electronic or mechanical, including 
photocopying, recording, video copying, or any information storage and retrieval system, is 
strictly prohibited by law. All rights reserved. Except as stated above, this Agreement does 
not grant you any intellectual property rights in the Software.  
 
Non-Transferable License  
You may not permit other individuals to use the product except under the terms listed 
above. The Licensee may not sell, rent, lease, or otherwise transfer rights to the product. The 
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Licensee may not modify, translate, decompile, decrypt, extract, or create derivative works 
based on the product. 
 
Disclaimer 
When images are mixed & matched, vendors do not guarantee that all designs created in 
Studio can be fabricated exactly like the rendering. While we have tried to be as accurate as 
possible with the details of each vendor image, we do not guarantee the names & sizes of 
these images. Please refer to the actual vendor catalog for exact specifications. Ultimately, 
you, the designer, are responsible for fabricating designs created in Minutes Matter Studio. 
 
Termination and Indemnity  
Without prejudice to any other rights of the Licensor, this Agreement will terminate 
automatically if the Licensee fails to comply with its terms and conditions. The Licensee 
agrees to indemnify, defend and hold Licensor, its partners, affiliates, licensors, contractors, 
officers, directors, employees, and agents harmless from all damages, losses, and expenses 
arising directly and indirectly from your acts in using the Software. 
 

System Requirements  
 

Minimum Operating System 
Hard Drive Space: 50 MB Available 
Processor: 600 MHZ (Pentium III) 
Memory: 64 MB 
Video Card/Memory: 16 MB 
Operating System: Windows 98 or higher 
Screen Resolution: The screen resolution must be set to a minimum of 1024 x 768. 
Minutes Matter Studio will not install on a lower resolution. 
Notebook Computers: Creating a rendering is more difficult when using a touch pad, 
therefore, an external mouse is needed to effectively drag & drop images.  
 
Mac Users 
Studio is Mac compatible for computers which have an Intel processor and Parallels 
Desktop for Mac software. This will allow you to switch between Mac OS X/Leopard and 
Windows XP/Vista. Visit: http://www.apple.com/getamac/everything-ready.html to learn 
more. 

http://www.apple.com/getamac/everything-ready.html
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Buying a new computer 
If your computer meets Studio’s System Requirements, it is not necessary to purchase a new 
computer to use the Minutes Matter Studio Software. However, we often receive questions 
about what type of computer to purchase when users decide to upgrade. Below are our 
recommendations. Have fun shopping! 
 
Now that you are a “Graphic Artist,” you may want to consider purchasing a new computer 
that will handle graphics more efficiently. Graphic software programs have the ability to 
produce very large files sizes; text documents produce very small file sizes, so in the past you 
probably have not had the need for a computer with graphic capabilities. If your computer is 
more than three years old, consider purchasing a new computer in the near future.  
 
New computer recommendations 
Hard Drive Space: 100 GB 
Processor: 2.8 GHZ (or more) 
Memory: 1GB (or more) 
Video Card/Memory: 128 MB (minimum) - 256 MB (better) 
Operating System: Vista Ultimate (see requirements for Mac Users) 
Monitor Size: 19″ Desktop Computer (minimum) and 15″ (minimum) for Laptop computers. 
Working with small details is much easier with a larger monitor; you do not have to zoom in 
and out nearly as much. Also, you can set your screen resolution to 1280 x 1024 which 
allows you to view more workspace. 
Notebook Computers: Instead of purchasing a desktop computer, consider purchasing a 
notebook with a docking station. This way when you are docked, you can use a large 
monitor and external keyboard. However, when you need to run out of the office, you can 
simply undock your computer and take it with you. When working with a notebook it is 
important to use an external mouse to effectively drag & drop images. Clicking and dragging 
images onto the workspace is more difficult when using a touch pad. 
Warranty: We recommend an on-site warranty for your new computer. If something goes 
wrong with your computer, the technician will come to you instead of having to ship the 
computer back to the manufacturer. 
Where to purchase: Wholesale Clubs can be a great place to purchase a computer since 
they offer a 90 to 180 day return policy. However, purchasing from a computer 
manufacturer, i.e., Dell or Gateway will allow you to customize your computer and add the 
on-site warranty and/or the docking station to your purchase.  
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Installation Requirements  
 

You must be logged on as the Administrator to install Studio. Also, the monitor resolution 
must be set to a minimum of 1024 x 768. Minutes Matter Studio will not install on a lower 
screen resolution. For Windows XP, NT & 2000 change the screen resolution by clicking on 
the Start Button > click Settings > click Control Panel > click Display > click on the 
Settings Tab & change the Screen Resolution to at least 1024 x 768. 
 

Activate 
 

During your trial period, press the “Try Studio” button each time you open Studio. The 30-
day trial begins when you install Studio. Once you have purchased the program, click the 
“Email Code” button to send us your unique Product Code. When we process your order 
and receive your Product Code, the office will email you an Activation Code. Enter this code 
then press the “Activate” button. Each company is entitled to two licenses. Each computer 
will produce a different/unique Product Code; therefore, both codes will be needed. If you 
only have one computer, you may activate one license and wait to activate your second 
license when it is needed. NOTE: You must be logged on as the Administrator during 
Activation. 
 

  

Product Code 
Displayed Here 

Enter Activation 
Code Here 

Days Remaining 
Displayed Here 

Unique Code
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Abbreviations 
 

General 
 
 
 
 
 
 
 
Size 
 
Size 
 
  
Position 
 
 
 
Doors & Windows 
 
 
 
 
 
 
 
 
Hard Treatments 
 
 
 
 
Note 
M’Fay Patterns, finial hardware & trims are listed by the number. PK represents Parkhill, 
MM represents Minutes Matter Instructional System & PM represents Pate-Meadows 
Designs. 

Ga or Gath...... Gathered
P or Plt................. Pleated 
R .............................Ruffle 
B........................... Balloon 
Drap ....................Drapery 
H.............................. Horn 

J ................................ Jabot
Mt...........................Mount 
P ...............................Panel 
R........................... Rosette 
Ret......................... Return 
RP .................Rod Pocket 

S ................................Swag 
Slv ...........................Sleeve 
T.................................. Tail 
TB...................... Tie Back 
V ..........................Valance 
 

A ............................... Arch
AA ...............Access Arch 
AE ........... Arch Eyebrow 
AQ ............ Arch Quarter 
C .......................Casement 

DH............ Double Hung
F ............ French or Fixed 
G ........................... Gothic 
O ...............................Oval 
R.............................Round 

S .............................Sliding 
ST .....................Slant Top 
T.........................Transom 
Q.............................. Quad 

Ex ............................ Extra
Lg............................. Large 
Sm............................ Small 

XL................. Extra Long
Med.....................Medium 

Sht............................ Short 
SP...................Short Point 

B........................... Bottom
C ............................ Center 

E.................................End
L ......................Lead Edge 

T................................. Top 

AB ....... Aluminum Blind
BCT.... Blind Cloth Tape 

PS ..........................Pleated
S.............................Shutter 

V ................Vertical Blind 
WB............... Wood Blind 
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Hot Keys 

 
 
 
 
 
 
 

Studio Tour 
 

Descriptions 
Mouse over or hover over any icon or tool to display image specifications or descriptions. 
Button descriptions will also display in the bottom left corner of the program. 
 
Images 
Studio’s images are related to actual room measurements. The size of images can be changed 
by typing the measurement in real world sizes. For instance, when a window measures 36″ x 
72″, these are the dimensions you would type in the program. No conversions are necessary! 
Studio’s Elevation page default scale is 1″ = 20″. Studio’s Space Planner default scale is 1″ = 
48″; however, the scale can be altered which will be discussed later.  
 
Time Saver 
Speed up the design process by using hot keys to access features & functions faster. Use 
CTRL+Z to undo the last action, CTRL+S to save & CTRL+P to print. A list of all hot keys 
is located above, as well as inside the Menu Bar. 
 
Saving Designs 
As soon as a new file is opened, press CTRL+S or click File > select Save > locate “My 
Studio Designs”. It is important to spend time setting up a comprehensive filing system to 
store Studio renderings, fabrics, & downloadable files (see Filing, Saving, & Emailing – Creating 
Your Filing System.) Every file that refers to Studio should be placed inside of “My Studio 
Designs” folder, then locate the appropriate subfolder. Press CTRL+S often while designing 
to continually save the latest updates.  
 

Undo................ CTRL+Z
Redo ................ CTRL+Y 
Cut ................... CTRL+X 
Copy .................CTRL+C 
Paste................. CTRL+V 

Save................... CTRL+S
New .................CTRL+N 
Open................CTRL+O 
Duplicate.........CTRL+D 
Select All ......... CTRL+A 

Group.............. CTRL+G 
Ungroup ..........CTRL+U 
Refresh Screen ............ F5 
Print.................. CTRL+P 
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Workspace 
When Minutes Matter Studio is opened, the white rectangle in the center of the screen is 
referred to as the workspace or paper size; all renderings are created in this space. The gray 
area is referred to as the Background. When designing, all objects must fit within the 
workspace in order to print. Any object that touches the gray background will not print 
correctly. The screenshot below provides a description of the workspace which will be 
discussed throughout this manual. 
 
 

 
 
 
Remember 
Remember to design inside your workspace. Objects that touch the gray background will not 
print properly. 
 

Workspace

Background

Elevation Images

Space Planning Images

Page Tabs
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Studio versions 
 

Minutes Matter understands that sometimes it is the little things that make the biggest 
impact. Our products & services are based on that concept. We do everything we can to 
make your experience with us an extraordinary one! That’s why we offer a variety of ways to 
purchase Studio. This allows us to meet your needs & your budget! Then when you’re ready, 
you can upgrade at any time. (Current pricing is available on our website.) 
 
Differences between versions 
 

Studio Planner 
Studio Planner is a floor planning software program which allows you to move furniture 
with a click of a button! Simply drag & drop images to see where to place furniture in your 
room setting. All images are rendered to scale & are filled with a neutral color to make 
illustrating even faster! If you desire, you have the option to change the colors or even add 
fabrics to the space planning images. 
 
Studio 2.0 
Create beautiful window treatment illustrations to scale using Studio 2.0. Now every detail of 
the design can be evaluated before fabrication begins, including color & fabric selection. 
With a computerized rendering of the treatment, alterations & design concepts can be 
quickly developed without the costly expense of redrawing the treatment by hand or creating 
a mock up in the workroom.  
 
Studio Lite 
Studio Lite is a subset of Studio 2.0 which includes all the core functionality needed to 
design window treatment renderings. Studio Lite is an affordable, creative environment, 
designed to support users as graphic skills are developed. To create more advanced 
renderings, Studio 2.0 would be the recommended version since Studio Lite does not include 
fabric, layers, transparency or the skew/perspective features. 
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Studio Design 
Studio Design allows you to create custom window treatment illustrations (Studio 2.0) & 
design floor plans (Studio Planner) all while working within a single program. Explore the 
endless possibilities of digital renderings tailored for your specific needs. This computer 
program maximizes the design process, saves hours of time during consultations, and 
eliminates costly communication errors!  
 
Studio Design Suite 
Studio Design Suite allows you to create custom window treatment illustrations (Studio 2.0), 
design floor plans (Studio Planner), and immediately quote the treatment during a consultation 
using QuickBooks & Quoting 7.1! We make it easy to consolidate your estimating & 
accounting processes in your existing QuickBooks program. Design a treatment in Studio, 
and then use QuickBooks & Quoting 7.1 to determine the yardage & create your estimate! 
 
Modules 
Mix and match to suit your business needs! Additional images can be added to your existing 
2.0 program. Modules will include Living Room Furniture, Bedding Basics, Bedding 
Advanced, etc. Visit our website to view a list of all the available modules. 
 
Learn more 
Visit our website at www.minutesmatterstudio.com to watch the video clips & learn more 
about this impressive program!  
 
Note 
After your trial period ends, certain features within the program may disappear depending on 
which Studio version you purchase. This manual discusses every feature within the program 
so you can use all of Studio’s capabilities during the trial period. 
 
Payment Plan 
 

There has never been a better time to make such a wise investment for your company! The 
Payment Plan allows you begin implementing Studio into your business immediately - then 
pay for it over time with three low installments that are easy to fit into your budget. Since 
you will be closing more sales, Studio can actually pay for itself before your last installment is 
due! To learn more, visit www.minutesmatterstudio.com. 
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Using Toolbars 
 

Top Toolbars 

 
Document Bar 
 

 

New (CTRL + N) – Press to start a new drawing. 
 

 

Open (CTRL + O) – Press to open a drawing. 
 

 

Save (CTRL + S) – Press to save a drawing. 
 

 

Undo (CTRL + Z) – Press to undo last action. 
 

 

Redo (CTRL + Y) – Press to restore an action that was undone. 
 

 

Cut (CTRL + X) – Press to remove & save a selected object to be used at another time. 

 

Copy (CTRL + C) – Press to copy a selected object so that it may be used at a later time. 

 

Paste (CTRL +V) – Paste the copied object into the current document. 

 

Toggle Toolbox – Press to toggle Toolbox on or off. This displays or removes the Toolbox on the 
left side of the workspace. 

 

Toggle Rulers – Press to toggle rulers on or off. This displays or removes rulers around the 
workspace. 

 

Add New Page – Press to add new page(s) to current document. Select Elevations or Space 
Planning then press OK. 

 

Remove Page – Press to remove a page(s) in current document. 
 

 

Print (CTRL+P) – Press to print drawing on screen. 
 

 

Email Us – Press to email technical support questions to the Minutes Matter staff. 
 

 

About – Press to display the software version being used. 
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Graph & Guideline Tools 
 

 

Graph Paper – A series of lines that are used to precisely align & position objects on workspace; 
default = 5″ per block. When designing, Graph Paper can be toggled on & off by pressing & 
depressing the Graph Paper button. 
 

 

Snap to Graph Paper – When pressed, objects snap to the closest Graph Paper line. 
 

 

Snap to Object – When pressed, one object snaps to the next closest object.  
 

 

Guide Lines – Guidelines are used to reference points on the screen. When designing, Guide Lines 
can be toggled on & off by pressing & depressing the Guide Lines button. (To permanently remove the 
Guidelines, follow steps below to add or remove Guidelines.) 
 

Adding Guide Lines: To drag a Guide Line onto the workspace, move the cursor near the inside 
edge of the Ruler Bar (closest to the workspace); the cursor will turn into a double arrow. Click, hold & 
drag the Guide Line onto the desired area of the workspace. 
 

Deleting Guide Lines: To delete a Guide Line, right click on the Guide Line > select Guide Line 
> select Delete Guide Line. 
 

Tip: Before adding a treatment, use Guide Lines to reference the sides or the top of the window. 
These lines are visible only on the screen; Guide Lines will not print. 
 

  

 
 

 
Auto Pan – Select the tool then click, hold & drag the mouse to control which part of the drawing is 
visible on the workspace. 
 

Guide Lines 
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Layer Tools 
 

Using Layers provides flexibility when organizing, displaying & editing designs. Divide a 
drawing into multiple layers; each layer will contain a portion of the drawing’s content. For 
example, create a layer called Trim, Workroom Specs or any other group that would be 
helpful in the design, and then assign certain objects to the appropriate layer. Once the trim 
is assigned to a layer, you can hide the trim to increase the drawing speed and make 
manipulating the remaining images much easier. The following screen shot demonstrates the 
various layers that were created in a rendering. 
 

 
 
 
 
 
 
 
 
 
 

 

Layers – To set Layers, click on the Layers button > click New > click Rename & type in an 
appropriate name such as Wall Layout, Design, Furniture, Hardware, Trim, Text & Workroom 
Specs. 
 
When using Layers it is best to assign the layers in the order the design is being created. Activate the 
Layers feature by creating a new layer; every object brought onto the workspace will be assigned to 
that layer. Start building a design with the Wall Layout. This layer would include items such as 
molding, windows, doors & floor. Next create a second layer called Design & begin adding window 
treatments; continue adding layers as needed. 
 
Reassign Layers: Select the object or images then click on the Layers down arrow (see above screen 
shot) to select a new layer from the drop down menu. 
 
Showing & Printing Layers: Once layers have been created, click on the Layers button > uncheck 
the Visible box on a layer such as Furniture & Accessories > press OK. Now all of the objects 
assigned to the Furniture & Accessories layer will disappear. Follow the same steps to check the 
Visible box again; the Furniture & Accessories will reappear. Decide what Layers will be printed by 
following the same steps. For example, a design can be printed with or without trim. 
 

View the Tutorial for video 
demonstration of using the Layers 
feature. 
 
Creating Layers is an advanced tool. 
When designing, using Layers is an 
optional feature & is not required. 
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Image List 
 

 

Image List – Displays a list of all images that are used on the workspace (use this list to determine image 
names; e.g., item number or name after the image is placed on the workspace.)  This list is also used to locate an 
image that has been protected from “selection” (see Fundamentals – Protecting Images.) 
 
Print List: The Image List can also be printed & placed in the client’s file by pressing the Print 
Button. Note: Images that are grouped will not be individually displayed. The name & caption will 
display “Group”. 
 

 
Image List – Displays all images used in design 

 
 
 
Zoom Tools 
 

Change the view of a drawing by zooming in to get a closer look or by zooming out to see 
more of the drawing. Zoom tools do not affect the size of objects or how the page will print. 
These tools only affect the viewing size displayed on the screen. It is the same effect a 
magnifying glass has on an object. 
 

 

Zoom -25% – Each click zooms out/farther 25% 
 

 

Zoom +25% – Each click zooms in/closer 25%. 
 

 

Set Scale 100% – Resets zoom scale to 100%. 
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Zoom to Fit Page – Zooms out to show entire page.  
 

 

Zoom to Fit Page Width – Zooms out to show full width of page. 
 

 

Zoom Within Rect. (Rectangle) – Select the tool (mouse will turn into a magnifying glass) then click, hold 
& drag the dotted box around desired area. 
 
IMPORTANT: Zoom Within Rect. must be deselected after use. To deselect, click on the Zoom 
Within Rect. button again. 
 

 
Format Tools 
 

 

Bold – Select the text, press Bold to bold text. 
 

 

Italic – Select the text, press Italic to italicize text. 
 

 

Underline – Select the text, press Underline to underline text. 
 

 

Left Align – Select the text, press Left Align to align text to the left. 
 

 

Center Text – Select the text, press Center Text to center the text. 
 

 

Right Align – Select the text, press Right Align to align text to the right. 
 

 

Increase Font – Select the text, press Increase Font to enlarge the size. 
 

 

Decrease Font – Select the text, press Decrease Font to reduce the size. 
 

 

Font Color – Select an object, click Font Color down arrow > click More Colors > Custom > 
click & drag the mouse around the color palette to choose any color from the RGB scale. Once a 
hue is selected, use the sliding scale to make the color lighter or darker. Press OK to return to the 
workspace. 
 

 

Line Color – Select a line or object, click Line Color down arrow > click More Colors > Custom 
> click & drag the mouse around the color palette to choose any color from the RGB scale. Once a 
hue is selected, use the sliding scale to make the color lighter or darker. Press OK to return to the 
workspace. 
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Fill Color – Select an object, click Fill Color down arrow > click More Colors > Custom > click 
& drag the mouse around the color palette to choose any color from the RGB scale. Once a hue is 
selected, use the sliding scale to make the color lighter or darker. Press OK to return to the 
workspace. 
 

 

Line Width – Select a line or object, press Line Width to change the thickness of the outline. Select 
None to remove the outline from an object (this will not remove lines from an image.) 
 

 

Line Style – Select a line, press Line Style to choose the type of outline; ex: dotted, dashed, solid. 
 

 
Transparency 
 

 
Transparency – Applying transparency will change the opacity of an object; this tool is used for 
sheer fabrics & making the glass in a window transparent. 
 

 
Transparency Tool – Move sliding bar or type the percentage value 

 
Apply Transparency to Entire Object: To make the entire object transparent, select the object & 
slide the Transparency Bar to set the value of the transparency or type the value into the 
Transparency Box. The smaller the transparency value, the more the object will appear sheer. 
 

Apply Transparency to an Individual Piece: By default, Studio applies the transparency to both 
the fill & the outline. However, the transparency can be applied only to the object’s fill, while leaving 
the outline solid. The same can be done for the glass inside windows or doors. To make an 
individual part transparent, select the object, such as a window > right click > select Image 
Components > select the Glass text > press the Fill button > slide the transparency bar to 
approximately 30% > press OK. 
 

Remove Transparency: If there is no longer a desire to have an object be transparent, select the 
object & set the transparency value back to 100%. 
 

 
 



 
Using Toolbars  – 17 – 

 Use the Transparency feature to trace around an object to create your own custom shape. This 
feature is also ideal when designing on a photograph that is not a straight on view. Making the 
images transparent allows the alignment of the treatment to be verified on the photograph. Once the 
desired shape has been traced or the correct alignment has been achieved, return the transparency 
value back to 100%. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Side Toolbar 
 

IMPORTANT: When drawing custom shapes it is important to remember that only tools 
with green icons can be filled with color.  
 
Select Tools 
 

Before an object can be edited, it must be selected. Select either an individual object or 
multiple objects. When an object is selected, green edit points will appear to indicate that the 
object can be filled with fabric, made transparent or the size may be altered. 
 
 

 

Select – Click on an object by using the Select tool. 
 
Tip: When the Select Tool is activated, multiple objects can also be selected by holding down the 
Shift key while clicking on each object. 
 

Trace around objects Verify alignment 
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Select Multiple Objects – Press the Select Multiple Objects tool then click on each object. These 
objects can then be grouped or moved at the same time. 
 

 
Edit Points 
 

Objects can be manipulated by moving Edit Points. Edit Points are tiny green squares that 
display along the object’s outline. Changing the position of the Edit Points allows a shape to 
be finely tuned. Free Line, Free Close Line, & Polygon can be edited. Studio Images cannot 
be edited with the Edit Points tool. 
 

 

Edit Points – Single click on an object, press Edit Points; green squares appear around the object. 
Edit Points can be repositioned by clicking, holding & dragging the Edit Point. Zoom in on an 
object when working with Edit Points. 
 

Add Edit Points: Additional Edit Points can be added by holding down the Ctrl key while single 
clicking on the outline. 
 

Delete Edit Points: Delete Edit Points by holding the Ctrl key while single clicking on the existing 
edit points. 
 
 

 
The lampshade was drawn with the Polygon Tool 
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Line Tools 
 

 

Line – Select the tool then click, hold & drag on the workspace to draw a line. Release the click to 
end the line. 

 

Arrow Line – Select the tool then click, hold & drag on the workspace to draw a line with an arrow 
on the end. Release the click to end the line. 
 

Tip: To draw a straight line, press the Shift Key while dragging the line across the page. 
 

 

Straight Line – Select the tool then click, hold & drag on the workspace to draw a perfectly straight 
vertical or horizontal line. Release the click to end the line. 
 

 
Callout Tools 
 

The Callout Tool is used to draw attention to details or point out instructions for fabrication. 
When this curved line is drawn, one end will point to an area of the treatment & the other 
end of the curve can display text describing the detail. This tool is also very useful to add 
additional gather lines when more fullness is needed. 
 

 

Callout Tool – Select the tool then click, hold & drag diagonally on the workspace to create a 
curved line, drawing attention to specific details on designs. Release the click to end the shape. 
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Drawing shapes with curves 
 

These tools can be used when creating a custom arch, scallop or to add more gather lines. 
These shapes can also be stretched to create a half circle or an elliptical arch. 
 

 
 

Arch – Select the tool then click, hold & drag on the workspace to create an arched line. Release the 
click to end the shape. 

 
 

Pie – Select the tool then click, hold & drag on the workspace until an ellipse is drawn. Once the 
click is released, a line will appear that goes from the center of the circle to the cursor. Click on the 
right side & pull the line to the left side (the line appears to be erasing.) Click the left side to end the 
shape.  
 

Tip: This shape can be filled with color. 
 

 Note: When any of these shapes are selected, the shape can be adjusted by dragging the yellow edit 
points. 
 

 
 
Dimension Tool 
 

The Dimension Tool is essential when creating scaled renderings. This tool has infinite 
possibilities. For example, use the Dimension Tool to determine short points, long points, 
mounting height, width & drop of a swag, length of a jabot, distance between windows & 
the height from floor to ceiling, just to name a few.  
 

 

Dimension Tool – Select the tool, press the Shift Key, click, hold & drag on the workspace to 
draw a vertical or horizontal line. Release the click to end the line; the dimension will instantly 
display. Right click on the Dimension Line to type in the exact width or height.  
 

Tip: When drawing a horizontal Dimension Line, draw left to right. Opposite direction will result in 
an inverted dimension. For a vertical Dimension line; draw top to bottom.  
 
Rounding Numbers for the Dimension Line: The Dimension Line has been set to round to the 
nearest .25 inch. For example, if you type 4.46″ the Dimension Line will round up to 4.50″. 
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Dimension Tool – Displaying different dimensions on top treatment 

 

 
Drawing custom shapes 
 

Create any desired shape by drawing with the following tools. These tools are often used to 
create objects such as tables, chairs, slipcovers, lighting, custom accessories & floral 
arrangements. The only limit to these tools is your imagination! 
 

 

Free Line – Select the tool then click, hold & drag on the workspace to create a free formed line. 
Release the click to end the line. This tool resembles drawing with a pencil. 
 

 

Free Close Line – Select the tool then click, hold & drag on the workspace to create a free formed 
line. Release the click to end the shape.  
 

Tip: When drawing, a straight line will extend to the pencil; this tool joins the start & the end 
creating a shape that can be filled with color. 
 

 
Polyline – Select the tool then click on the workspace, continue clicking to create the desired shape. 
Double click to end the shape. Edit Points will be made at each click. 
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Polygon Tool – Select the tool then click on the workspace, continue clicking to create the desired 
shape. Double click to end the shape. Edit Points will be created at each click. 
 

Tip: When drawing, a straight line will extend to the cursor; this tool joins the start & the end 
creating a shape that can be filled with color. 
 

The Polygon Tool is the most popular drawing tool. This tool can be used to draw banding, trace 
objects on a photograph or can be used to alter Studio images.  
 

Edit Studio Images with Polygon Tool: Below is an example of using the Polygon Tool to edit a 
Studio Image. Draw a rough shape over some of the existing fold lines to remove fullness. Once the 
shape has been drawn, remove the outline. Continue this process to remove as many fold lines as 
needed. The below screen shot shows the difference this technique has made. This technique can be 
used with images that have been filled with fabric; however, the repeat may be interrupted. The 
Polygon shapes in the center image have been filled with gray for illustration purposes. 
 

 
Original Studio image (left), polygon tool shapes on image (center), corrected image (right) 

 

 
Trace Photographs: The Polygon Tool was used to trace around the photograph of the lamp. Add 
artistic touches by adding highlights & shadowing. With a little practice this tool can expand your 
creativity.  
 

Tip: Practice drawing around objects in a photograph. This is a great way to become familiar with 
this tool. 

 
Polygon Tool – Tracing around an object 

 
 

Single click to 
create each 
edit point 



 
Using Toolbars  – 23 – 

Drawing basic shapes 
 

These tools are used to quickly draw basic shapes. These shapes can be used to create a wall 
that will fill with color, floors that can be filled with a wood texture & custom picture 
frames. 
 

 

Circle – Select the tool then click, hold & drag on the workspace to create a circle. Release the click 
to end the shape. 
 

Tip: This shape can be filled with color. 
 

 

Rectangle – Select the tool then click, hold & drag on the workspace to create a rectangle. Release 
the click to end the shape. 
 

Create a Square: To create a perfect square, hold the Shift Key down while drawing with the 
Rectangle tool. 
 

Tip: This shape can be filled with color. 
 

 

Round Rectangle – Select the tool then click, hold & drag on the workspace to create a rectangle 
with rounded corners. Release the click to end the shape. 
 

Create a Square: To create a perfect square with rounded corners, hold the Shift Key down while 
drawing with the Round Rectangle tool. 
 

Tip: This shape can be filled with color. 
 

 

Close Bezier Line – Select the tool then click on the workspace. Continue clicking to create the 
desired shape. Double click to end the shape. Edit Points will be made at each click.  
 

Tip: When drawing, a straight line will extend to the cursor; this tool joins the start & the end 
creating a shape that can be filled with color. 
 

 

Bezier Line – Select the tool then click on the workspace. Continue clicking to create the desired 
shape. Double click to end the shape. Edit Points will be made at each click.  
 

Tip: This tool is used to create a curved line. 
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Text Tool 
 

Use the Text Tool to add important information to the rendering. This information would 
include workroom specifications, company information & copyright symbol. 
 
 

 

Text Tool – Select the tool then click, hold & drag on the workspace to create the desired Text box 
size. Double click inside the Text box (a cursor will appear), and type desired information.  
 

Tip: Use the formatting tools to change the font style, bold, color or align the text. Formatting will 
be displayed after deselecting the Text box; click out of the Text box to deselect. 
 

Formatting tools will apply to all of the text inside the Text box. Multiple text boxes will need to be 
created if different formatting styles are desired. 
 

 
Text box 

 
 

 
Import Image 
 
 

 

Import Image – Select the Import Image button > click on the upper left corner of the 
workspace > an Import Dialog Box will appear; select a .jpg, .bmp, .gif, .ico, .png, .wmf or .emf 
file (locate photographs that have been taken with a digital camera and saved to your computer) & press Open.  
 
Remember, the image must fit inside the workspace in order to print. Minor size adjustments can be 
made if necessary to fit on the page. Any image that touches the gray background will not print 
correctly. 
 
Tip: Decrease the photograph size enough that a white margin surrounds the photograph. 
 

Center Image: Move the mouse inside the image (under the cursor a crosshair with arrows will appear) > 
click, hold & drag the image into the center of the workspace.  
 

 

To learn more about setting the drawing scale in the photograph & protecting the image, 
please refer to the Photograph chapter in this manual. 
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Importing an Image – Photograph centered on page (white workspace) 

 
Photo Clip 
 

Use the Photo Clip tool to place an image behind an object in a photograph. For example, a 
drapery panel can appear to be behind the couch. 
 
 

Photo Clip – Before placing images on the photograph, select Photo Clip tool > single click 
around the object which needs to be moved, continue clicking to trace around the image entire 
object > double click to end the process. Edit Points will be created at each click. After ending the 
process, a duplicate image will be created. Drag over the desired window treatment images > select 
the duplicate image (sofa) > press the Bring To Front button on the bottom toolbar. 
 

 
To learn more about the Photo Clip tool, please refer to the Photograph chapter in this 
manual. 
 
Insert Table 
 

Use the Insert Table tool to create a proposal with a cost chart, a signature line or to display 
a list of fabric names & colors. 
 
 



 
– 26 –  Using Toolbars 

 

Table – Select the tool then click, hold & drag on the workspace to create the desired Table size > a 
Table Dialog Box will appear; type in the desired number of Columns & Rows > press OK. 
 

 
Alter Text: Double click on the text inside the Table & type desired information. 
 

 
Table – Used to create a simple estimate 

 

Bottom Toolbar 

 
Rotate Tools 
 

Studio allows an image or custom shape to be rotated to any desired degree. However, the 
Rotation Tool does not apply to imported photographs or logos. 
 

 

Free Rotate – Select an object; notice a rotation handle appears at the top of the object. Hover the 
mouse over the round circle to change the cursor to a circular arrow. Click, hold & drag the circle 
to rotate the object to any desired degree. Release the mouse click to stop rotation. If the rotation 
is too extreme, press CTRL+Z to undo the rotation. Display or remove the rotation handle by 
selecting the object, and then toggle the Free Rotate button on or off.  
 

 
Free Rotate – Use top handle to rotate any image 
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Free Mirror – Select or group desired objects to be mirrored > press the Free Mirror button > 
click, hold & drag the red center line to the desired half way point > hover over any edit point 
surrounding the original object, your curser will change to twin rectangles > press the CTRL key 
while clicking & dragging the edit point to the side > release the click and the mirrored image will 
automatically be positioned. 
 

 
 

To learn more about the Free Mirror tool, please refer to the Fundamentals 
chapter in this manual. 
 
 

 

Rotate Left – Press to rotate the selected object to the left in 90º increments. 
 

 

Rotate Right – Press to rotate the selected object to the right in 90º increments. 
 

 

Flip Horizontal – Press to flip the selected object from left to right or right to left. 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 

Flip Horizontal – Create one side of treatment then duplicate & flip to produce a right side 
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Flip Vertical – Press to flip the selected object from top to bottom or bottom to top. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Flip Vertical – Create the top ruffle then duplicate & flip to produce bottom ruffle 

 

 
Group & Ungroup 
 
 
 

 

Group (CTRL+G) – Select two or more objects, press Group to treat the objects as a single unit. 
This allows the same fill to be applied, the size to be adjusted or objects to be moved together. 
 

TIP: When shapes are grouped, all objects have combined Edit Points. 
 

 
Group – Three objects grouped 

 

Ungroup (CTRL+U) – Select one or more grouped objects, press Ungroup to break the 
combined objects apart. 
 

TIP: When shapes are ungrouped, each object has separate Edit Points. 
 

 
Ungroup – Three objects selected ungrouped 
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Lock & Unlock 
 
 
 

 

Lock – Lock objects to prevent objects from moving. When designing, it is a good idea to lock 
objects such as baseboards or windows. Locked objects can be filled & deleted. 
 

Tip: Shapes that are locked will have small pad locks surrounding the objects when selected. 
 

 
Group – Three objects grouped 

 

 

Unlock – Unlocks locked objects. Objects can then be freely moved. 
 

 
Alignment Tools 
 

Use the alignment tools to quickly position objects in relation to other objects on the page. 
The alignment is determined by the order of selection. For example, select three objects by 
drawing a box around them. The last object in the box selected will be the reference point 
for aligning when Align Left is pressed. When objects are selected individually, the last 
object selected will be the reference point for the alignment.  
 

 

Align Left – Select two or more objects, press Align Left to have objects align to the left edge. 
 

 
 
 

Not aligned Aligned left
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Align Top – Select two or more objects, press Align Top to have objects align to the top edge. 
 

 
 

 

 

Align Bottom – Select two or more objects, press Align Bottom to have objects align to the 
bottom edge. 
 

 
 
 

 

Align Right – Select two or more objects, press Align Right to have objects align to the right 
edge. 
 

 
 
 

 

Align Middle – Select two or more objects, press Align Middle to have objects align to the 
horizontal center. 

 
 

Not aligned Aligned top

Not aligned Aligned bottom

Not aligned Aligned right

Not aligned Aligned middle
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Align Center – Select two or more objects, press Align Center to have objects align to the 
vertical center. 

 
 

 

Center In Page (Horizontal) – Select two or more objects, press Center In Page (Horizontal) to 
center objects evenly from the left & right side of the page. 
 

 

Center In Page (Vertical) – Select two or more objects, press Center In Page (Vertical) to center 
objects evenly from the top & bottom of the page. 
 

 
 

Spacing Tools 
 

Use these tools to quickly space objects according to other objects on the page. 
 

 

Space Across – Press to create even, horizontal spacing between selected objects. Three or more 
objects must be selected to activate this tool.  
 
Tip: Use this tool to space rings on a pole. Place the first & the last ring at desired location on the 
pole > select all the rings > then press Space Across button > press Align Top button. 
 
 
 

Not aligned Aligned center

Not spaced evenly Space evenly 
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Space Down – Press to create even, vertical spacing between selected objects. Three or more 
objects must be selected to activate this tool. 
 

 
 
 

 

 
 

Sizing Tools 
 

Use these tools to quickly adjust the size of objects in relation to other objects on the page. 
The size is determined by the order of selection. If objects are selected one at a time, the last 
object selected will be the reference point for sizing. When these tools are used, the sizing 
corresponds to the perimeter of the edit point box. For example, if you have two images 
grouped and then use the same width, same length, or same height tools, then the third 
image will match the size of both of the images which are grouped. 
 

 

Same Width – Select two or more objects, press Same Width to adjust width to be the same. 
 

 
 

 

Same Height – Select two or more objects, press Same Height to adjust height to be the same. 
 

 

Not spaced 
evenly 

Spaced 
evenly 

Not the 
same width 

Same width

Not the
same height 

Same height
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Same Size – Select two or more objects, press Same Size to adjust width & height to be the same. 
 

 

 
Order of objects 
 

All Studio designs have an order in which they are drawn. For example, the wall is the first 
object in the stacking order, the window is the second object in the stacking order, the 
roman shade is the third object in the stacking order & the cornice is the fourth object in the 
stacking order. The following buttons allow the order of these objects to be changed. These 
tools are used if an image appears “lost” behind a photograph or wall. Simply select the 
photo or wall and press Send to Back to locate the “lost” image. 
 

  
 

 

Bring to Front – Select an object, press Bring Forward. This moves the object to the very top of 
the stack. 

 
Select window & press Bring to Front 

 

Not the 
same size 

Same size

4th object  

3rd object  

2nd object  

1st object  
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Send to Back – Select an object, press Send to Back. This moves the object to the very bottom 
of the stack. 
 
Caution: This button sends objects to the very back of all other objects. For example, objects on 
top of a photograph can “disappear” when Send To Back is pressed; the object goes behind the 
photograph. Press CTRL+Z to undo the Send to Back. 
 

 
Select window & press Send to Back (notice window “disappears” behind wall) 

 

 

Send Forward – Select an object, press Bring Forward. This moves an object up one place in 
the stacking order. Continue pressing the Bring Forward button to move the object forward 
one position at a time until the desired location is obtained. 

 

Send Backward – Select an object, press Send Backward. This moves an object down one place 
in the stacking order. Continue pressing the Send Backward button to move the object back 
one position at a time until the desired location is obtained. 

 
Nudge Tools 
 

 

Nudge Left – Press to move the selected object to the left in micro increments. Use arrow keys 
on the keyboard to move in larger increments. 

 

Nudge Right – Press to move the selected object to the right in micro increments. Use arrow 
keys on the keyboard to move in larger increments. 

 

Nudge Top – Press to move the selected object up in micro increments. Use arrow keys on the 
keyboard to move in larger increments. 

 

Nudge Bottom – Press to move the selected object down in micro increments. Use arrow keys 
on the keyboard to move in larger increments. 
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Filing, Saving & Emailing 
 

Creating your filing system 
 

It is important to spend time setting up a comprehensive filing system to store Studio 
renderings, fabrics & downloaded files. It will be of little value to spend time creating 
renderings if they cannot be located. Every file that refers to Studio should be placed inside 
of “My Studio Designs” file folder. 
 
To save a file, select File > select Open (CTLR+O) > under “My Documents” locate 
“My Studio Designs” > locate the appropriate subfolder to store your file. In the “Clients” 
folder create subfolders of your clients’ last names. Fabric samples should be saved under 
the appropriate client folder.  
 
Create a New Folder: To create a new folder, simply click on the New Folder icon & type 
a name.  

 
Create a filing system under “My Studio Designs” 

 

Saving & finding lost files 
 

When starting a new design, press Ctrl +S or click File & select Save > locate “My Studio 
Designs” & save the design into the appropriate subfolder. It is very important to save all 
Studio files inside of “My Studio Designs”. 
 



 
– 36–  Filing, Saving & Emailing 

Be sure to press Ctrl +S (Save) often while designing. This will continually save the latest 
update for your design. 
 
When you are unable to locate a file or design, more than likely, it was saved somewhere 
other than inside “My Studio Designs” folder. Click the Start Button > select Search > 
select All files & folders > type in a word of the file name > under Look In, select either 
“My Documents” or “My Computer” > click the Search button to begin the search. 
 

 

 
  
 
 

Opening saved files 
 

IMPORTANT: Open a saved/existing file. When your program contains the space 
planning images, two pages will appear in the document: Tab 1: Elevations & Tab 2: Space 
Planning. When the file is first opened, the page tab will default to the first page of the 
document. For example, if you have created a floor plan, the Elevation page will be blank 
because you did not create your illustration on that page. Click on the Space Planning Tab to 
view your illustration. 
 

Exporting & emailing designs 
 

To email a Studio design to a client, the file must be exported prior to emailing. Studio files 
(.mms files) are proprietary files that will only open inside Studio; in other words, a person 
must have Studio installed on their computer to open a .mms file. Therefore, do not email a 
Studio file (.mms) to a client; the file must be exported in a .jpg format. A .jpg is a safe, 
universal format that any computer user can open. 

Search for a lost file Entering search criteria  
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Export a Design 
Open the client’s rendering (.mms file) > click File > click Export > select .jpg as file 
type > press Save > a screen will pop-up, choose medium quality to export. To email 
multiple pages, you must export each page separately.  
 
Export Options 
Selecting the “quality” changes the pixels and the size of the file. Low quality (96 DPI) is for 
screen viewing only and creates the smallest file size. Medium quality (150 DPI) creates a 
small file that is good when emailing a design to a client. High quality (300 DPI) should be 
used when the design will be printed for a presentation. Very high quality (600 DPI) should 
be used when the rendering needs to be enlarged for signs or posters. 
 
View All Saved Files 
When you click Open, the program will display only the saved .mms files. To view every file 
saved in a folder click on Files of Type > Select All Files. All files, both .mms & .jpg files, 
will be visible. It is important to remember that only .mms files can be “opened” with 
Studio. Other files, such as .jpg files, must be “imported” using the Import Image tool. 
 
Email a Design  
After exporting the file, select File > select Open (CTRL+O) > select All Files for file 
type > right click on the .jpeg file > select Send To > Mail Recipient. This will 
automatically open your email program.  

          
Displays all file types                                                                             Email .jpg file to client 
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The Workspace 
 

The file folders 
 

All Studio images are located inside file folders in the Toolbox & are ready to use as soon as 
you open the program. View the contents of any file folder by simply double clicking on the 
desired folder. 
 
The Elevation Index is divided into several main categories: Templates, Windows and 
Doors, Room Elements, Window Treatments, Furniture, Lighting, Accessories, and Color 
Palette. Inside the Window Treatment folders are Quick Designs which contain completed 
designs. Individual pieces of each design can be found in the Pieces & Parts section. These 
pieces are used when a Quick Design does not meet the needs of the rendering. Move the 
mouse over each image icon to display detailed information such as pattern names, numbers 
& recommended pattern sizes. Throughout the Index folders abbreviations are used. Images 
with numbers represent patterns from M’Fay, images with MM represent instructions from 
Minutes Matter Instructional System, images with PM represent patterns from Pate-
Meadows Designs & images with PH represent Parkhill Royale Swag System. To see a 
complete list of abbreviations visit Getting Started – Abbreviations. When an image has 
been selected, click, hold & drag the image onto the workspace. (see Fundamentals - Drag & 
Drop Images) 
 
Tip: When a larger workspace is needed, especially when working on a smaller monitor, you 
can temporarily remove the Toolbox. Press the Toggle Toolbox button to toggle the 
toolbox on or off. This displays or removes the Toolbox on the left side of the workspace.  
 
Here are a few file folder examples which are located in the Elevation index: 
 

 

The Embellish folder has several subfolders. The D’Kei folder includes trims & tassels. The Details 
folder includes bows, rosettes & tiebacks. The Heading folder includes images such as rod pockets, 
various pleat headings & ties.  

 

The Hard Treatment folder contains blinds, shades, shutters & verticals. 
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The Hardware folder has hardware products such as finials, poles, holdbacks & rings from a variety 
of vendors. 

 

The Room Elements folder includes fireplaces, lighting, accessories & wall layouts. Bay & corner 
window angles can quickly be achieved by using the wall layouts that are provided. 
 

 

The Specialty folder contains images for arch windows & sunburst treatments. 

 

The Windows & Doors folder includes four different styles. Choose from plain windows /doors, 
windows/doors with casings, windows/doors with grilles or windows/doors with grilles & casings. 

 
The Color Palette folder contains designer paint colors from Benjamin Moore. The Color Palette is 
only a sample of colors that can be utilized. Match any color being displayed on the screen or 
match colors in a photograph by using the Eyedropper tool. 
 

 

Tip: Toggle Toolbox on or off by pressing the Toggle Toolbox button. 
 

 

Ruler Bars 
 

Studio has included preset rulers which have a small page margin built-in. The ruler bars can 
be turned on or off by pressing the Toggle Rulers button.  
 
These ruler bars are not set up like a normal ruler or tape measure. The ruler bars are set 
according to the drawing scale. For example, the Elevation drawing scale is defaulted to 1″ = 
20″ in the real world; therefore, you will see a 20″ mark, a 40″ mark & so on. When Studio’s 
drawing scale is changed to 1″ = 48″, the ruler bar will reflect the new scale. 
 

 
Default Ruler Bar - 1″ = 20″ 

 

 
Drawing Scale changed to reflect new Ruler Bar – 1″ = 48″ 
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Altering the workspace 

 
About the Drawing Scale 
 

For example, when designing an extra wide wall, it may only be necessary to change the 
paper size to legal instead of altering the drawing scale. However, when the window wall is 
larger than the legal paper, the drawing scale can be altered by either editing the Drawing 
Scale or the Wall Size. This chapter will describe how to use both of these options. It is only 
necessary to change either the Drawing Scale or the Wall Size, since Studio automatically 
adjusts the other scale. The Graph Paper is also automatically adjusted when the drawing 
scale is changed (see The Workspace - Ruler Bars). 
 
The drawing scale should be changed BEFORE BEGINNING A DESIGN. Since all the 
Elevation images are based on a 1″ = 20″ scale, the size of each image will need to be 
adjusted when the drawing scale is altered. In the example below the window measures 35″ x 
60″ when the drawing scale is 1″ = 20″, Studio’s default scale. Change the drawing scale to 1″ 
= 30″, notice the window measurement changes to 52.5″ x 97.5″. The icon measurement in 
the main index folder remains the same even when the drawing scale is changed. The 
window appears to be the same size on the screen, however, when the image is selected the 
1″ = 30″ scale displays a much larger size; right click to change the dimension of the 
window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1″ = 20″ Drawing Scale 1″ = 30″ Drawing Scale 
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Edit Drawing Scale 
 

Customize Studio’s drawing scale by clicking Page > Edit Drawing Scale. The default 
Elevation scale is 1″ = 20″. This scale has been chosen as the default so a large window wall 
can print on a standard paper size while still being able to display details of the treatment.  
However, when a 1/4″ scale is desired, click Page > click Edit Drawing Scale > type in 1″ 
= 48″ > press OK to return to the workspace. The image sizes must be changed according 
to the drawing scale. 
 
Note: The Space Planning tab default scale is set to 1″ = 48″. This scale is smaller so that an 
entire floor can fit on the workspace. 
 

 
Edit Drawing Scale 

 
 
 
 
 
 
 
 
 

1″ = 48″ Scale  1″ = 20″ Scale  
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Edit Wall Size 
 

The second way to alter the drawing scale is to Edit the Wall Size. When a wall size is 
larger than 160″ high x 208″ wide, the wall size must be altered before you begin designing. 
Click Page > click Edit Wall Size > type in the largest measurement using either the width 
or the height of the room > press OK to return to the workspace. 
 

 
 
 
 
 
 
 
 
 
When returning to the workspace, the width of the page is actually larger than the 
measurement that was entered. Studio automatically adjusts the measurements to fit on the 
selected paper size. To determine the EXACT wall size, use the Rectangle Tool > draw a 
rectangle on the workspace > with the Rectangle Tool selected, right click > select 
Change Dimensions > UNCHECK the Keep Aspect Ratio > type in the height & the 
width of the wall. Now the rectangle can be protected from being printed or selected (see 
Fundamentals - Protecting Images.) Crown & baseboard can be added at this point. 
 

Multiple pages 
 

There will be times when additional pages need to be added to a design. Studio only prints 
the page being displayed on the screen, therefore, it is necessary to open each page & press 
CTRL+P to print. Also, when emailing multiple pages, you must export each page 
separately. 
 
 

Edit Wall Size Type largest wall measurement 
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Duplicate Page 
To duplicate everything being displayed on the screen, click Page > click Duplicate Page. 
All the images will be copied to the new page. 
 
 

 
Duplicate Page 

 
 
New/Blank Page 
When a new/blank page is desired, right click on the Page Tab > click Add Page > choose 
Space Planning or Elevations > click OK. 
 
Rename Page 
Each page can be named with a descriptive title, right click on the Page Tab > click Page 
Caption > remove the current text (Elevations /Space Planning) > type in the appropriate text. 
 
 
 
 
 
 

Rename a pageAdd a page
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Fundamentals 
 

Drag & drop images 
 

Studio is a drag & drop software program. To access the Studio images, simply double click 
on a file folder in the Tool Box. The folder will then display all images located inside the 
folder. Many folders also contain a Quick Designs folder; double click to display contents 
(see The Workspace – The File Folders.) Single click on an icon then click, hold & drag the image 
onto the workspace. 
 

Personalizing Wall Templates 
 

We recommend customizing the wall templates with your logo and company information. 
Using templates will speed up the design process. Start an elevation rendering by opening 
the Templates file folder. Locate the template that most resembles your client’s room. Drag 
the template onto the workspace. 
 
Logo and Company Information:  Import your logo by clicking the Import Image 
button > single click on the workspace > an Import Dialog Box will appear; select a 
.jpg, .bmp, .gif, .ico, .png, .wmf or .emf file of your logo & press Open (see Using Toolbars – 
Import Image). Resize and adjust the logo to the desired size and position. Use the text box to 
add your company information (see Using Toolbars – Text Tool.)  
 
Save the File: To save a file, select File > select Save As… > under “My Documents” 
locate “My Studio Designs” > locate the “Template Folder” > name the file “9ft Wall 
Template w Logo” > press Save. (see Filing, Saving & Emailing – Creating your filing system.) 
Use these customized templates when beginning every new rendering. Be sure to use “Save 
As” > rename the file and save the file in your client’s folder. This will keep your template 
intact.  
 
Altering the template: When necessary, the template can be easily altered by selecting the 
template on the workspace > press Ctrl+U to ungroup the template > click on the window 
and press Ctrl +D to delete the window > drag another window onto the template. 
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Selecting images 
 

There are three ways to select images: Using the Select Tool, Select Multiple Objects Tool or 
encompass the images by dragging the cursor around the desired images.  
 

 

First Option: Click on object by using the Select Tool. When the Select Tool is activated, multiple 
objects can still be selected by holding down the Shift key while clicking on each object. 

 

Second Option: Press the Select Multiple Objects button then click on each object. These objects 
can then be grouped or moved at the same time.  

 

Example of a company template
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Third Option: Use the mouse to totally encompass the desired images. Only images within 
the dotted box will be selected. It is important to start the selection process in a blank space. 
For example, when the selection is started on an image, the program assumes the image is 
being selected.  
  
Click, hold & drag a dotted box around the desired images. After the box has been drawn, 
release the click & edit points will appear around the images that have been selected. Notice 
the crown & baseboard were not included in the selection; only the window & drapery were 
encompassed by the dotted box.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Resizing images 
 

There are two ways to resize an image: Type in a dimension or drag the Edit Points. 
 
First Option: Resize the selected image by typing in the exact dimension. Single click to 
select the image > right click > select Change Dimensions, uncheck the Keep Aspect 
Ratio box (if you do not want the window to resize proportionally) > type in the desired 
dimension > press OK. When the Keep Aspect Ratio button is checked, the image will 
enlarge or decrease proportionally in both width & length. When the Keep Aspect Ratio is 
unchecked, you can type in a width, however, the length remains the same. Press OK to save 
your changes. 

Encompass desired image inside dotted box Images that were encompassed in the dotted box have 
been selected. 
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Second Option: Resize the selected image by dragging the green Edit Points. To resize an 
image proportionally, push or pull on the corner edit points. To widen an image, pull on 
one of the side edit points; to lengthen an image, pull on one of the top or bottom edit 
points. 
 
Another feature of Studio is the size indicator. This indicator displays the dimensions of the 
image or images that are selected. This indicator is located in the bottom right corner of the 
program. Remember, these images relate to actual room measurements, so no conversions 
are required!  
 
The location of the selected image in relation to your page is also displayed next to the size 
indicator bar. 
 
 
 
 
 
 
 
 
 
 

 
 

Drag any Edit Point to resize image Right Click > Change Dimensions

Status Bar displays the selected image’s location & size

Size of imageLocation of image



 
Fundamentals  – 49– 

Protecting images 
 

Protect an Image: Protecting images allows you to select from many different options. For 
example, protect an image from being selected, printed or filled. This feature is very useful 
when designing on a photograph or when the design needs to be printed without printing 
the trim. To access this feature select the image(s) > right click > select Properties > select 
Protection > place a check mark in the appropriate protection box. 
 

 

Unprotect an Image: When an image has been protected from being selected, you can no longer 
right click on the image. To remove the protection, click the Image List button & highlight the 
protected image > press the Protect button > uncheck the appropriate protection box. 
 
If images have been grouped, use the Lock button instead of using the Protection feature. It is 
easier to unlock grouped images than it is to individually unprotect each image. 
 

 

 
Protection dialog box 

 

 
Use the Image Button to remove “protect image from being selected” 
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Perspective & Skew Tool 
 

Studio has one of the easiest & most dynamic Perspective Tools ever created. To activate 
the Perspective & Skew Tool, double click on a selected image, the green Edit Points will 
turn red > click, hold & drag the red Edit Points to create a perspective or skew angle > 
when the correct angle has been achieved, press CTRL+D to duplicate > press Flip 
Horizontal to create the other side. Drag the corner edit points to create a perspective 
angle. Drag the center edit points to create a skewed effect. 
 
 
 

 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Perspective Tool 
Using the Perspective Tool gives objects the appearance of receding into a vanishing point; 
therefore, the design has a sense of depth. This tool is perfect for creating a bay or corner 
window. Complete a design as a straight on view; include the window, treatments, 
moldings, walls, etc. Altering a completed design eliminates the need to convert each 
individual image to a perspective angle. At this time, save the finished straight on view 

Drag corner edit 
points to create 

perspective 

Drag center 
edit point to 

create skewed 
effect 

Skew tool Perspective tool 
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rendering. Once the design has been created > select all of the images > press CTRL+G to 
group > turn the graph paper on to help alter the angle of the top & bottom of the image to 
the same degree > double click on the grouped images to activate the Perspective Tool > 
drag the red Edit Points straight up or down to the desired angle. Once the design has been 
changed into a perspective angle, press Save As… & add (perspective) to the file name. When 
the angle of a design has been altered, it is very difficult to revert back to a straight on view if 
other changes need to be made at a later time. This is why we recommend saving the file 
with two separate file names. 
 

Skew Tool 
Skewing an image will slant the image to a specific degree. This tool is used to skew multiple 
pieces of trim to fit the angle of an image or alter images to fit on a photograph that has 
been taken at an angle. 
 
Measuring Perspective/Skew Renderings 
When the Perspective or Skew Tool is used, the inside edge of the rendering should not be 
altered since this represents the true measurements of the room. The outside edge DOES 
NOT display accurate measurements. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Turn on graph paper & 
count same blocks up 

and same amount down 
Skew images for photos

Skew pieces of trim

Measuring Rooms with 
Perspective Angles 

The side not 
altered 

represents true 
measurements 
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Adding trim 
 

Adding trim to a design is a great way to show a client the difference trim can make on 
custom window treatments. Learning these tips will make adding trim very easy. 
 
Zoom in to see details 
When working with trim use the Zoom Within Rectangle button; remember to deselect the 
zoom tool (see Toolbars - Zoom Tools.) 
 
Spacing trim 
Save time by spacing the trim further apart; it is not necessary to have the trim touching. 
Using this technique can also reduce the file size. The extra spacing is not visible when 
printed. 
 
Enlarging Trim 
All trim images are drawn to scale, therefore, do not distort the size by enlarging. To show 
detail, duplicate & enlarge a piece of trim at the bottom of the page. This tip also applies to 
hardware products. When a finial or trim is enlarged, the image is no longer to scale & 
cannot be ordered in that size. 
 
Stacking Order 
When adding trim to horns, jabots, drapery panels, etc., start applying the trim at the bottom 
& work up. If the order is reversed, the trim will not lay correctly. 
 
Duplicating Images 
If the same image is used several times throughout the rendering, apply trim to a single 
image, group, and duplicate the image as needed for the remaining design. This will make 
creating the design much faster since trim does not have to be applied to each individual 
piece. 
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Quick Tips 
Drag a piece of trim onto the workspace > add color to the trim before duplicating > while 
holding the CTRL key down, click, hold & drag off a duplicate piece of trim > place the 
duplicate piece at the desired location on the treatment > continue this process until the left 
half of the image is completed > select all the trim > press CTRL+D to duplicate > press 
the Flip Horizontal button > move the trim to the proper place on the right side of the 
treatment > add or remove individual strands as necessary > select all the trim > press 
CTRL+G to group. The file can then be manipulated easier.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Start adding trim at bottom 
of cascade 

Space trim further apart to 
save time & enlarge one 

piece to show detail 

Duplicate & flip one side to 
create opposite side 

Completed image with trim 
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Mirror Designs 
 

The Free Mirror tool is an easy way to create the exact same treatment on two windows. 
Using this tool will create a duplicate the same height, size and the exact distance from the 
center point without the use of additional tools. 
 
Step One (design): 
Create a finished design which should include the window, treatments, trim, hardware, etc. 
 
Step Two (locate the center): 

If necessary, use a Dimension Line to locate the center point between the two 
treatments. Select the Dimension Tool, press the Shift Key, click, hold & drag on 
the workspace to draw a horizontal line. Release the click to end the line; the 

dimension will instantly display. Right click on the Dimension Line to type in the exact 
measurement.  
 
 
Step Three (mirror - center line): 

Select the finished design > press the Free Mirror tool > a red center line with a 
green cross hair at the top & bottom will appear > click, hold, & drag the center 
line to the end of the dimension line. 

 

 

Mirror Tool – Center Line 
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Step Four (mirror – dragging edit points): 
Once the Free Mirror center line is positioned > click on any of the edit points surrounding 
the original design, your cursor will turn into a twin rectangle > press the CTRL key while 
clicking & dragging the edit point to the side to create the duplicate image. The 
duplicate image will be positioned according to the placement of the center line.  
 
IMPORTANT: A duplicate image will only be created by holding down the CTRL key. If 
you do not press this key when dragging the edit point, the image will flip to the other side. 
You can only create a duplicate if you hold down the CTRL key while dragging the edit 
point. 
 

 
 
  
 

Once the center line 
has been positioned, 
click and drag an edit 

point to the side 
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Applying Fabrics & Colors 
 
There are three ways to access the fill options: Fill Color (paint bucket icon), Eyedropper tool 
or by right clicking on an image > click Properties > Fill. 
 

Fill Color (paint bucket icon) 
 

Select an image(s) > click the Fill Color button. Choose any color from the entire RGB 
scale by clicking More Colors > Custom > click & drag the mouse around the color scale; 
once a color is selected, use the sliding scale to go lighter or darker > click Add Custom 
Color button to save the color > press OK to return to the workspace. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Eye Dropper 
 

Inside Fill Color is an Eyedropper tool. The Eyedropper tool is only for Windows 2000, XP 
& Vista users. The Eyedropper tool is not compatible with Windows 98 or ME Operating 
Systems. The Eyedropper tool can be used to select hues from the Color Palette folder, a 
website or a photograph. Select an image(s) > open the Color Palette folder inside the 
index & locate the desired color > click the Fill Color button > click More Colors > click, 
hold & drag the Eyedropper over a color > press OK to return to the workspace. 
 

RGB scaleFill color button
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Match Photograph Colors 
To match a color with the Eyedropper tool, the color must be displayed on the screen. 
When matching a color in a photograph, sometimes the More Colors dialog box opens on 
top of the image you want to match; therefore, the color is not displaying on the screen. 
Click, hold & drag the More Colors toolbar (click beside the More Colors text) to move the dialog 
box to the corner of the workspace. Now the photograph will be viewable on the screen. 
 
Match Paint Website Colors 
The Eyedropper tool can also be used to match a color on a website, i.e. Benjamin Moore’s 
paint website. Open Studio > using the Internet, locate a color on paint website > right 
click on an empty spot on the Taskbar > select Tile Windows Vertically. Both programs 
will automatically be tiled beside each other. To remove tiling, click Undo Tile. 
 

Note: In order for the tiling option to work, you must have Studio and the website open at 
the same time. Try the other tiling options to see how it arranges the programs differently. 
 

 
Right click on Taskbar 

Fill color button Eyedropper tool

Right Click Here 
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Fill with Patterns, Gradient Fills, Textures or Fabrics 
 

Select an image or images > right click > select Properties > Fill > select the appropriate 
tab & follow the below directions (depending on which tab is selected). 
 

Pattern Fill 
The Pattern effect is useful when needing a generic plaid or stripe. Change the color of the 
pattern & the pattern’s background to any solid color desired. Just like filling with a solid 
color, select from any hue on the entire RGB scale or use the Eyedropper tool to match a 
specific color. 
 

Gradient Fill 
The Gradient effect is perfect for creating metal hardware finishes & giving solid fabrics, like 
silk, more dimension. Just like in the Pattern tab, the colors of the gradient values can be 
changed. 
 

Texture Fill 
The textures can be used to simulate flooring, hardware finishes & finishes for window trim. 
Click on the desired texture & press OK to apply the effect to the image. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Texture tab

Pattern tab

Gradient tab 

Right click to select image 
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Fabric Fill 
The fourth tab is the Fabric tab. Personalize each rendering by adding the customer’s fabric, 
hardware texture & wallpaper. Before we add fabric, let’s take a moment to learn how the 
Fabric Fill works. 
 

Acquiring Fabrics 
 

There are several ways of acquiring fabric images to import into Studio. 
 

Website 
When available, the best choice for acquiring fabric is from a fabric vendor’s website. Many 
fabric vendors have downloadable files for fabrics. Locate the desired fabric on a website, if 
possible use fabrics with full repeats > right click on the fabric image > click Save Picture 
As... > save the file under My Studio Designs within the appropriate client folder> name the 
fabric sample with the pattern name, color & repeat. 
 

Scanning 
A fabric swatch can be scanned, however, there are disadvantages to scanning. Most 
scanners are not able to accommodate a full repeat, therefore, only a small sample will be 
captured. 
 

Photograph 
Another option is to take a photograph of the fabric. When setting up for the photo shoot, 
hang the fabric or tape it to the wall in a well lit area. Hanging the fabric will help reduce 
wrinkles. Wrinkles should absolutely be eliminated before taking the picture. Also, consider 
taking the picture outside in natural light to reduce the chance of shadows. 
 
 
 
 
 
 
 
 
 

Locate fabric on vendor website > right click 
on the fabric > Save As…. 
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Cropping Fabrics 
 

To make fabric appear seamless when tiled, crop out backgrounds or dark edges before 
loading the fabric. Import fabrics that have been properly cropped from repeat to repeat. 
When images have not been properly cropped, the fabric will appear to be blocked instead 
of appearing seamless. We recommend using a photo editing software to crop the fabric. If 
you do not have a photo editing software, we recommend a free program, called Irfanview. 
This software is great for editing fabrics. You can find a link to download this program on 
our website, click System on the menu bar > Fabric Editing Software. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
Crop a fabric using Irfanview 
 

Step One (resize): 
Open Irfanview > click File > click Open > locate the fabric file > press OK. When the 
image is large the fabric might need to be resized by clicking Image > click 
Resize/Resample & reduce the image 25% to fit the screen. 
 

Step Two (rotate): 
The image may need to be rotated slightly. Click Image > click Custom/Fine Rotation > 
type the angle degree. 
 

Properly cropped Not cropped 

Dark edges 

White edges 

Crop repeat to 
repeat 
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Step Three (crop): 
Crop the fabric from repeat to repeat. Click, hold & drag to draw a box selecting the 
horizontal & vertical repeat. The crop marks can be adjusted by moving the crop lines. Once 
the box is positioned correctly, click Edit > Crop Selection. Press File > Save As > name 
the fabric & add “cropped” to the file name. The folder will contain two fabric images; the 
original image & the cropped image. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Cropping in Irfanview 

Resizing in Irfanview Rotating in Irfanview 
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Loading Fabrics 

Right click on the selected image or images > select Properties > Fill > select the Fabric 
tab > CLICK ON A GRAY EMPTY BOX > click the Load button > locate the desired 
fabric; the fabric will appear in the gray box. 
 
Edit fabric size 
Select the fabric in the box > press the Edit button > type in the appropriate size of the 
fabric. Be sure the Keep Aspect Ratio button is checked. This will size the fabric 
proportionally. If desired, add the vendor name & name of fabric > press OK to return to 
the workspace. 
 
Multiple fabrics 
To load multiple fabrics continue the above process, however, make sure to click on the 
GRAY EMPTY BOX so the previously loaded fabrics are not replaced with the new fabric. 
 
Delete fabrics 
It is best to delete any unused fabrics to reduce the file size. To delete a fabric, select the 
unwanted fabric box > press the Delete button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 Loading & deleting fabric images Editing fabric size according to size displayed 

Delete used fabrics to 
reduce file size 
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Fabric Tips 

Below are several suggestions when working with fabrics. These tips will help the rendering 
accurately display the effect the fabric has on the overall design. 
 
Check Repeat of Fabric 
It is important that the fabric repeat is accurately represented in a rendering. When a repeat 
is too large or too small the treatment will not look like the rendering when fabricated. An 
easy way to check the repeat of a pattern is to create a rectangle approximately 54″ wide by 
36″ > fill the rectangle with the fabric > use the Dimension Tool to check the repeat. For 
demonstration, the diagram below has been filled with a Monkey print with a repeat of 6″. 
Zoom in > snap a Dimension Line to check the accuracy of the repeat. Adjust the fabric as 
needed until the fabric repeat is correct (see Adding Fabrics & Colors – Loading Fabrics/Edit 
Size). 
 
 

 
Edit fabric image to accurately display fabric scale. Left illustration has not been edited to correct size.  
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Stripe Fabric 
Use the following technique to give a continuous appearance to stripe fabrics. For this tip, 
you will need to know the length of the image being filled. Once the fabric has been loaded 
into Studio, press the Edit button > UNCHECK Keep Aspect Ratio > type in the correct 
fabric width & type the length of the image (not the fabric length). When the image is 
filled notice how the stripe has a continuous appearance, as opposed to the block effect that 
is created when the Aspect Ratio button is checked. This tip is only beneficial when working 
with stripe fabrics. 
 
 
 
 
 
 
 
 
 
 
 
 

Stripe fabrics – UNCHECK Keep Aspect Ratio box & type the length of the image size 

 
Copying into New Document 
Each file or new design saves the fabric associated with that rendering. The fabrics that have 
been saved will not copy into a new document. The fabrics will need to be reloaded into a 
new document. In other words, the images will copy into a new document but the fabrics 
will not copy. When an image(s) that has been filled with fabric is copied into a new 
document, the image(s) will turn gray. When the same fabric will be used in a different 
design, duplicate a page to begin your rendering. The fabric image will be transferred using 
the duplicate page feature. After duplicating the page, you may add or delete the images.   
 
Other uses 
The Fabric tab can also be used to add wallpaper, flooring, custom textures or fill glass with 
an outdoor scene. 
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Filling contrast 
 

The contrast fabric of jabots, top treatments, embellishments & all Quick Designs can 
quickly be filled with a specific color or fabric. To fill an image with contrasting color, select 
the image > right click > select Image Components. A list of all the parts in the image 
will be displayed. For example, the list can include Face Fabric, Contrast Fabric & Outline. 
Select the Contrast Fabric & press the Fill button. Choose the Pattern tab, Gradient tab, 
Texture tab or Fabric tab. (Refer to the Filling Images directions for step-by-step instructions on how to 
use each tab.) To change the Face Fabric, select Face Fabric line from the Image 
Component list & repeat the previous procedures. Notice how the Contrast Fabric of the 
drapery is filled with a solid color & the Face Fabric has been filled with a pattern. 
 
 
 
 
 
 
 
 
 
 

Image component list  

Select from the list, then 
click Fill 

Filling contrast

Contrast fabric 
has been filled 
with solid color 
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Photographs 
 

Photography tips 

Before you begin to design on a photograph for a client presentation, we recommend using a 
photo editing software to correct any flaws within the photograph. Your presentation to the 
client should be just that - A Presentation! Photographs can be too dark, contain undesirable 
objects, dull colors, flash reflections, items that need to be cropped out, etc. It is very easy to 
accomplish all of these tasks with a photo editing software. We recommend Adobe 
Photoshop Elements.  
 
The suggestions below are guidelines for taking great photographs to import into Studio. 
 

Angle 
When possible, stand directly in front of the window to take a picture. The scale of a 
photograph can be obtained much easier when the photograph has been taken as a straight 
on view. When the photograph is taken at an angle, one side of the rendering will not 
represent the true room measurements, much like images that are altered with the 
Perspective Tool. 
 

Lighting 
It is important to have proper lighting when taking a photograph. When a photograph is 
dark, it will be hard to match colors or see distinct details of the room. 
 

Importing a photograph 

To open a photograph in Studio you must use the Import Image feature. Click Zoom To 
Fit Page > click on the Import Image button > notice your cursor will change to a cross 
hair, single click on the upper left corner of the workspace > an Open Dialog Box will 
appear; locate your photograph select a .jpg, .bmp, .gif, .ico, .png, .wmf or .emf file > click 
Open. Once the photograph has been imported, click on a corner edit point and push the 
edit point in towards the center of the photograph to reduce the size. It is very important to 
make sure the entire photograph is on the white workspace. Then single click, hold and drag 
the photograph to the center of the workspace. 
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Setting the drawing scale 
 

Importing an image is discussed in the Toolbar section – Side Toolbar/Import Image. The 
drawing scale needs to be determined & adjusted if necessary before the design is created. 
Snap a Dimension Line on the window or any place where a room measurement is known. 
When the Dimension Line is snapped, the measurement will be smaller, larger or close to the 
correct size. The drawing scale needs to be adjusted until the Dimension Line is very close to 
the actual measurement. To adjust the drawing scale, click Page > click Edit Drawing 
Scale > type in a smaller number when the Dimension Line is too large > keep adjusting in 
1″ increments until the dimension is close to the room measurement. Further adjustments 
can be made by resizing the photograph with the Edit Points until the correct drawing scale 
is achieved. 
 
 
 
 
 
 
 
 
 
 

      
 

Drawing scale altered

Dimension line before drawing scale is altered Dimension line after drawing scale is altered 
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Photo Clip Tool 

There will be times when you need to move an object in a photograph. For example, in the 
below photograph, the furniture is located where a drapery panel needs to be placed. Use the 
Photo Clip tool to make the drapery panel appear to be behind the furniture. 
 

 
 
 
Step One (import the photo): 

Click the Import Image button > click on the upper left corner of the workspace 
> an Open Dialog Box will appear; locate your saved photograph & press Open. 
 

Step Two (Photo Clip tool): 
Before placing images on the photograph, select Photo Clip tool > single click 
around the object which needs to be moved, continue clicking to trace around the 
entire object > double click to end the process.  

 
Note: If you do not use the Photo Clip tool before adding the treatments to the photograph 
> select the photo > press the Bring To Front button (to bring the photo to the top layer) > use 
the Photo Clip tool (see above instructions) to trace around the obstructing object > select the 
original photo > press Send To Back button (moving the photo to the bottom layer). 
 

 

Drapery on top of object After Photo Clip Tool was used 



 
– 70 -–   Photographs 

Step Three (adjust as necessary): 
Edit Points will be created at each click. These edit points can be adjusted as 
necessary. Select the duplicate image > press the Edit Points button; green 

squares appear around the object. Reposition the Edit Points by clicking, holding & dragging 
the Edit Points.  
 
Step Four (move the layers): 

After using the Photo Clip Tool, a duplicate image will be created. Drag over the 
desired window treatment images > select the duplicate image (the furniture or object) 
> press the Bring To Front button on the bottom toolbar. 

 

Photo Knockout Tool 

The Photo Knockout feature is a great tool when you want to add furniture, artwork, plants, 
or accessories from a vendor’s website. This tool actually turns the solid background 
transparent.  
 
Step One (save the image from a website): 
Locate the desired image on a website > right click on the image > click Save Picture As... 
> save the image under My Studio Designs within the appropriate client folder.  
 
Step Two (add the saved image to Studio): 

Click the Import Image button > click on the upper left corner of the workspace 
> an Open Dialog Box will appear; select your saved image & press Open. 
 

Step Three (remove the background): 
Right click on the image > select Properties > select Fill. Studio automatically removes a 
white background. You can make small adjustments if necessary by moving the slider bar to 
the right or left. When an image has a background other than white; click, hold, and drag the 
Eyedropper tool to touch the colored background.  
 
Notes (when to use the Photo Clip): 
Some images may include the same color as the background. When this occurs be careful 
with the background adjustments or use the Photo Clip tool instead. Also, if the background 
is not a solid color, the Photo Clip tool should be used. 
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Protecting the photograph 

The final step before designing is to protect the photograph from being selected; this makes 
designing on the photograph much easier. Right click on the photo > select Properties > 
select Protection > place a check mark in the From Selection box. Using the Protection 
feature will prevent the photo from accidentally being selected when designing. There are 
times when an image can become “lost” because the image goes behind the photograph & 
cannot be seen. Since the photo has been protected, it is easy to locate the lost image by 
pressing CTRL+A to select all, and then press the Bring To Front button. (see Fundamentals 
- Protecting Images) 
 
 
 
 
 
 
 
 
 
 
 
 

Un-protecting the photograph 

After an image has been protected you are no longer able to right click on it to access Image 
Components. To unprotect an image, click the Image List icon > highlight the image > 
click Protect > uncheck the From Selection box.  

Image Lost (behind photo) Image found (on top of photo) 
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Space Planning 
 

Overview 
 

Studio Planner Index 
The Studio Planner images are located inside the Space Planning Index. Click Space Planning 
at the bottom of the ToolBox. Inside will be the Space Planning file folders. Depending on 
the Studio module purchased, you may see the Elevations Index, the Space Planning Index, 
or both inside the ToolBox.  
 

  
 
 
 
Workspace Drawing Scale 
Depending on the Studio module purchased, pre-set tabs will display at the bottom of the 
workspace; Elevation tab, Space Planning tab, or both tabs. The Drawing Scale on the 
Elevation workspace is pre-set to 1″ = 20″. The Drawing Scale on the Space Planning 
workspace is pre-set to 1″ = 48″. Before creating a room layout, select the Space Planning 

If you have purchased the 
Window Treatment 

module, you will see the 
Elevations Index. 

If you have purchased the 
Space Planning module, 

you will see the Space 
Planning Index. 
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tab. This will change the drawing scale to ¼″. If you accidentally create a floor plan on the 
Elevation workspace, which has a 1″ = 20″ drawing scale, there are two solutions to change 
the scale.  
 
Option One: The first option is to select all the images, (CTRL+A) to Select All > press 
(CTRL+C) to copy > click on the Space Planning workspace > paste the floor plan onto 
the space planning page (CTRL+V) to paste. 
 
Option Two: The second option is to change the Drawing Scale by clicking Page > Edit 
Drawing Scale > type in 48 for the World Distance. (see The Workspace - Edit Drawing Scale) 
Rename the tab by double clicking on the tab, and then replace the text. (see The Workspace - 
Multiple Pages/Rename Pages) 
 

 

 
Resizing & Filling Furniture Images 
Just like the Window Treatment images, all the Space Planning images can be resized, filled 
with color, or filled with fabric. To resize the furniture elements, select the image > right 
click > Change Dimensions > uncheck Keep Aspect Ratio > type in the desired width or 
length (see Fundamentals- Resizing Images.) Image colors can be altered or fabric can be added. 
(see Adding Fabrics & Colors) When adding a fabric, the fabric scale will need to be altered. (see 
Adding Fabrics & Colors – Loading Fabrics/Edit Size) However, it is not critical to add fabrics 
since this is a bird’s eye view and not an elevation view. Note: The space planning images 
are solid pieces of furniture; they are not designed to be transparent.  
 
Rotating & Flipping Furniture Images 
Space planning images can be rotated and flipped. The Free Rotate tool is the recommended 
tool when placing a piece of furniture at a 45º angle. Use the Rotate Left tool to rotate 90º to 
the left, use the Rotate Right tool to rotate the image 90º to the right, and Flip Vertical to 
rotate 180º. (see Toolbars – Bottom Toolbars/Rotate Tools) 

Click the Space 
Planning tab 

prior to creating 
a floor plan.  

This page scale 
has been pre-set 

to ¼″ 



 
Space Planning  – 75 – 

Creating the footprint 
 

There are four ways to draw your room’s footprint. No matter which option you choose, 
laying out the footprint will require the most time. However, once the footprint is complete, 
it is easy to add the room elements to show off your creativity. 
 
Basic Room Shape 
Select the Rectangle tool > click, hold, and drag any size rectangle shape on the workspace 
> right click > select Change Dimensions > uncheck Keep Aspect Ratio > type in the 
size of the room in inches and add 6″ to the width and length to allow for wall thickness > 
press Ok. Locate the walls inside the Architectural Elements folder > drag a wall onto 
the workspace > right click > select Change Dimensions > uncheck Keep Aspect Ratio 
> enter wall length. Since the wall is still selected, hold the shift key while single clicking on 
the rectangle, both images are now selected. Click the Align Top button and Align Left 
button to quickly position the wall. (see Toolbars – Bottom Toolbars/Alignment Tools) Continue 
this process until all walls have been added. Remember to use the Rotate Left tool to create 
your side walls. (see Toolbars – Bottom Toolbars/Rotate Tools)  
 
Design on a Blueprint 
The second method to create a room layout is to scan a blueprint, save it as a .jpg, then 
import the .jpg into Studio Planner. Click the Import Image button > then click on the 
top left corner of the workspace > locate the .jpg > press Open. (see Toolbar - Side 
Toolbar/Import Image) You will need to know one measurement of the blueprint. For the 
below example, we know that the loft space has an inside measurement of 144″. Draw a 
Dimension Line by clicking on the Dimension Tool > hold the shift key while dragging 
the Dimension Line across the page > right click on the Dimension Line > select 
Change Dimensions > type in 144″. Now resize or enlarge the .jpg to fit the Dimension 
Line. It is very important to zoom in to check the accuracy of this line. Once the .jpg image 
is adjusted, the entire room will be to scale. (see Designing on a Photo - Setting the Drawing Scale) 
At this point, you can protect the .jpg image from moving and begin dragging over the 
elements. (see Designing on a Photo - Protecting the Photograph) Remember, you are not able to add 
Studio’s flooring texture to a .jpg image. To add flooring, follow the instructions under 
“Completing the footprint”. 
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Draw the Layout Using the Blueprint 
To add a flooring texture to the footprint, follow the previous steps to correctly import & 
resize the blueprint. Use the Polygon Tool to trace around the interior walls. Click on the 
Polygon tool > draw around the inside edge of the walls & single click at each corner > 
double click to end the shape. (see Toolbars – Side Toolbar/Drawing Custom Shapes) Hold down 
the shift key as you draw the vertical and horizontal walls; holding the shift key creates a 
perfectly straight line. It is not necessary to hold the shift key when drawing a diagonal wall. 
To distinguish the polygon shape from the blueprint, fill the polygon shape with a floor 
texture by right clicking on the shape > select Properties > Fill > Texture > select a floor. 
Use the Transparency Tool to view the blueprint under the Polygon shape. Slide the 
Transparency bar to semi-opaque > zoom in > select the Edit Points button to reposition 
the nodes. Locate the walls and doors inside the Architectural Elements folder > place the 
interior wall, click and drag the wall to the correct size. Continue this process until all the 
interior/exterior walls, doors, and windows have been added. Once all the elements have 
been added, select the polygon shape again by single clicking, and then slide the 
Transparency bar back to 100%. (see Toolbars – Top Toolbar/Transparency) 
 

  
Trace over a blueprint with the Polygon Tool, then turn the Polygon shape semi-opaque to view blueprint underneath  
 

Use Dimension tool to 
verify measurements to 

match blueprint 
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Use Graph Paper to Draw 
There is another way to create a floor plan. When a blueprint is not available, use the Graph 
Paper to draw the floor plan. Studio has a unique feature which allows you to customize the 
Graph Paper. The Graph Paper can be toggled on and off by pressing the Graph Paper 
button. (see Toolbars – Top Toolbar/Graph & Guideline Tools) When the Graph Paper is visible, 
the default Grid size on the Space Planning workspace is pre-set to 12″. To change the 
Graph Paper Grid, click Page > Graph Paper Properties > change the horizontal and 
vertical spacing to the desired size. Then click on the Polygon Tool to begin drawing the 
footprint. Note: Changing the Graph Paper Grid does not alter the Drawing Scale. 
 

 
Graph paper spacing can be changed 

 

Completing the footprint 
 

Adding Flooring 
If the floor texture has not been added, highlight/select the Rectangle or Polygon shape > 
right click > select Properties > Fill > Texture Tab. There are several different flooring 
styles to choose from: carpet, brick, stone, tile, and wood. Click on the desired fill > press 
Ok. (see Adding Fabrics & Colors - Texture Fill) 
 
 

 
Flooring textures for space planning 

Space planning floor 
textures are located on 

the bottom row 
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Adding Windows & Doors 
When a blueprint is available, draw the footprint then add the windows and doors which are 
located in the Architectural Elements folder. (these images will need to be resized as necessary) To 
correctly position these elements, zoom in > select the Dimension Tool > hold the shift 
key while clicking and dragging on the workspace > right click on the Dimension Line > 
select Change Dimensions > type in the distance from the wall to the first window/door 
> reposition the Dimension Line to the correct position > locate desired window/door 
and drag it on top of the wall. Repeat this process for the remaining windows/doors. Note: 
Add a Door Opening to create a walk through before adding the door. 
 

 

 
Use Dimension Tool to confirm measurements 

 
 
 
Protecting the Footprint 
To make designing much easier, protect the footprint from being selected before adding 
furniture to the room. Press CTRL+A to select all the images on the workspace > right 
click > select Properties > select Protection > place a check mark in the From Moving 
box. Using the Protection feature will prevent the footprint from accidentally being moved 
while designing. (see Fundamentals - Protecting Images) 
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Tech Support 
 

Forum (The Lounge) 
 

One of the best forms of support is our online forum, The Lounge, which is located on our 
website. There is 24 hour a day access and best of all membership is FREE! View The 
Lounge video to get a personal tour of this great support tool! (A video is located beside The 
Lounge logo.) 
 
Register 
You will need to register for this free membership. Click on Register & follow the 
instructions. An email will be sent to your email address to verify your account. If you do 
not receive the email promptly, check your spam/deleted box. To complete your 
registration, click on the link included in the email. Once your membership is activated, 
you will have permission to upload files, download files & post questions. 
 

 
Click Register to join, and then post questions or comments in one of the five forums 
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Forum Basics 
The Lounge is divided into five forums. The first forum, Lounge Tips, contains detailed 
instructions on how to use the forum. The second forum, The Round Table, contains 
questions & helpful tips. Upload a .mms design to ask other members for design 
suggestions. The third forum, The Exchange, is divided into subcategories such as 
accessories, working with photographs, altering images, templates, etc. Members of “The 
Lounge” upload finished designs to share with others. The fourth forum, Announcements, 
discusses software updates, learning opportunities, and new products and events we will be 
attending. The last forum, Success Stories, shows how Studio has impacted the success of 
other businesses who have implemented Studio into their design process. To navigate inside 
The Lounge notice the filing system at the top; this displays your current location. To return 
to the Home Page of The Lounge, click on the text Minutes Matter Studio Lounge. 
 
 

 
Navigate quickly back to the main page of the forum, click Minutes Matter Studio Lounge 
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Start/Reply to a Thread 
All forums contain line items called Threads; inside the Threads are Replies. To start a 
thread, simply click on the New Thread button > enter a subject > type a message. To 
reply to a Thread, open the Thread > click on Post Reply > type your message. 
Remember, only those who have registered can post on The Lounge. 
 

 
 
 
 
 
 
 
 
 
 
 
Download Files 
Some threads contain attachments. The posts that display paperclips contain files that can be 
downloaded. Inside some threads, a zipped/compressed file can be downloaded, saved & 
opened with Studio. To download the file, click on the attachment > click Open > double 
click on the orange Studio file > click Open. The downloaded file will automatically open 
in Studio. Once the file is opened, it can be saved into the desired subfolder under My 
Studio Designs. 

 
Download a file – Single click on attachment, select Open 
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Attach Files 
When attaching files, the forum restricts the maximum size, width, and height of the files 
being uploaded. When the attachment does not meet the below requirements, the image will 
not be permitted to be uploaded. 
 

 
 
 
Upload files to share with other users. Click the Reply or New Thread button > enter a 
subject > type a message > at the bottom of the thread, under Additional Options, click 
Manage Attachments > click Browse > locate the file > right click on the desired Studio 
file > select Send To > select Compressed File; a new file folder with a zipper will appear. 
Select the Compressed File > click Open > click Upload > click Close This Window > 
click Submit Reply. (See the following screenshots) The file will be available for download on 
The Lounge. Upload a .jpg file by repeating the above steps, however, .jpg files do not need 
to be compressed.  
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Click Manage Attachments to begin the upload process 

 

 
Click Browse and locate file on your computer 

 

 
Compress .mms file before uploading to The Lounge 
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Tutorial 
 

To help make your design experience more enjoyable, we recommend viewing the Tutorial. 
This video demonstrates important features & functions of Studio. During the conclusion, 
we demonstrate creating a rendering from start to finish.  
 
The Tutorial was designed so that you can play, pause, rewind or stop at any time. Practice 
as you learn by resizing both the Tutorial & Studio; you can view both screens at the same 
time. The Tutorial will expand your graphic skills & increase your profits! 
 
To begin designing faster, simply spend half a day on Saturday with us (uninterrupted) to 
discover the secrets to success. We suggest watching the tutorial, one segment at a time, then 
practice what you've learned in Studio. 
 
 

 
Tutorial – Select a segment on the left, open Studio & practice what you have learned 
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Webinars & Learning CD’s 
 

We offer a variety of Webinars; live online seminars to help you quickly learn Studio. Due to 
popular demand, we recorded many of these sessions so you can view them at your 
convenience! Visit the website to see the current schedule of recorded and live topics being 
offered. 
 
The class subjects range to fit all levels of users. Classes are listed for beginners, intermediate 
& advanced users. The Basics session can be viewed online for FREE! When you are ready 
to learn more, purchase an advanced Learning CD. The Learning CD's let you explore 
Studio's features and learn creative design techniques at your own pace. A current list of 
Learning CD’s can be found on our website (www.minutesmatterstudio.com) under the “Support” 
tab on the menu bar. 
 

Contact us 
 

We recommend posting any questions you have on The Lounge, our online forum. When 
you post a question on The Lounge, it is instantly emailed to our tech support team to 
ensure a quick response. Since the forum contains thousands of posts (and growing every day), 
you can often find the answer you are looking for by simply searching the forum. 
 
We have received rave reviews regarding our customer service and tech support. By utilizing 
our various support options, you can quickly assist your clients in visualizing their dreams! 
 
Telephone ................................................................. 1.800.343.0616 
Fax.............................................................................. 1.615.826.0832 
Website ...................................................................... www.minutesmatterstudio.com 
Tech Support............................................................ techsupport@minutesmatterstudio.com  
Activate...................................................................... activate@minutesmatterstudio.com 
 
 
 
 
 

http://www.minutesmatterstudio.com/
mailto:techsupport@minutesmatterstudio.com
mailto:activate@minutesmatterstudio.com
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Index 

A 

Abbreviations, 6 
Activate, 5 
Align Tools, 28 
Attachments 

Forum, 79 
Sending file to a client, 37 

B 

Blueprints, use to create a footprint, 73 

C 

Callout Tool, 19 
Change dimensions, 47 
Circle, creating, 23 
Clipart 

Balloons, 86 
Cascades, 88 
Cornices, 93 
Draperies, 96 
Embellish, 104 
Hard Treatments, 108 
Hardware, 109 
Roman Shades, 116 
Room Elements, 118 
Space Planning, 147 
Specialty ‐ Sunburst, 123 
Specialty ‐Arches, 120 
Swags, 124 
Top Treatments, 131 
Windows & Doors, 134 

Computer, buying new, 4 
Contact us, 83 
Contrast on an image, filling, 65 
Cropping Fabrics, 59 
Curved shape, 20 
Custom shapes, drawing, 21 

D 

Delete fabrics, 62 
Design on a blueprint, 73 
Dimension Tool, 20, 63, 73, 76 
Display, 5 
Document Bar, 11 
Drag & drop, how‐to, 45 
Drawing a room layout, 73 
Drawing Scale 

Altering for a photograph, 68 
Changing, 41, 42 

Duplicating 
Images, 53 
Page, 44 
Trim, 53 

E 

Edit Points, 18 
Add, 18 
Delete, 18 
Dragging, 48 

Exporting 
Files, 37 
Options, 37 
Sending a file to a client, 37 

F 

Fabrics 
Adding multiple fabrics, 62 
Copying into a new document, 64 
Cropping, 59 
Deleting, 62 
Editing scale, 62 
Importing, 58 
Repeat, 63 
Stripe, 64 

File Folders, Studio’s Main index, 39 
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Files 
.jpg, 37 
Lost, 35 
Opening an existing file, 36 
Saving, 35 
Setting up file folders on your computer, 35 

Filling images 
With patterns, gradient, textures or fabrics, 57 
With solid color, 55 

Format Tools, 15 
Forum 

Attachments, 80 
Download files, 79 
Register, 77 
Reply to a thread, 79 
Tech Support, 77 

G 

Graph Paper, 12, 41 
Gray background, 8 
Group an image, 27 
Guide Lines 

Adding, 12 
Deleting, 12 

H 

Hot Keys, 7 
Hover, 7 

I 

Image Components, 65 
Image List, 14 
Images 

Can’t select an image, 49 
Contrast, filling, 65 
Do not distort, 52 
Drag & drop, how‐to, 45 
Eyedropper Tool, 55 
Format, 28 
Group an image, 27 
Importing an image, 24 

Lock an image, 28 
Protecting an image, 49 
Resizing images, 47 
Rotate an image, 26 
Selecting, 17, 46 
Ungroup an image, 27 
Unlock an image, 28 

Importing 
Fabrics, 58 
Images, 24 
Logos, 45 
Photographs, 24 

Importing photograph, 67 
Index Folders, 39 
Irfanview, 60 

K 

Keep Aspect Ratio, 47, 64, 73 

L 

Layers, 13 
Laying out a room, 73 
License Agreement, 2 
Lines, creating, 19 
Lock an image, 28 
Logo, adding to a file, 45 
Lost files, finding, 35 

M 

Mac Computers, 3 
Match paint colors, 56 
Mouse over, 7 
Multiple pages, create, 43 

N 

New computer recommendations, 4 
New page, 44 
Nudge Tools, 33 
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O 

Opening an existing file, 36 
Operating System, 3 
Order of objects, 32 

P 

Page 
Duplicate, 44 
New, 44 
Rename, 44 

Paint websites, 56 
Payment Plan, 10 
Perspective Tool 

Getting measurements correct, 51 
Using, 50 

Photo Clip Tool, 25, 69 
Photographs 

Altering the Drawing Scale, 68 
Designing on, 67 
Importing photograph, 67 
Lost image, 70 
Match colors on, 56 
Photo Clip Tool, 69 
Protecting a photograph from selection, 70 
Tips for taking the photograph, 67 
Unprotecting a photograph from selection, 70 

Polygon Tool, 22 
Protecting a photograph from selection, 70 
Protecting an image, 49 

R 

Rectangle, creating, 23 
Rename page, 44 
Repeats, fabric, 63 
Rotate an image, 26 
Ruler Bars, 40 

S 

Save file, 7 
Saving files, 35 

Screen Resolution, 5 
Selecting images, 17 
Size indicator bar, 48 
Skew Tool, 50, 51 
Space Across, 30 
Space Planning 

Adding flooring, 75 
Adding windows & doors, 76 
Creating the footprint, 73 
Default Scale, 7 
Design on a blueprint, 73 
Drawing scale, 71 
Drawing the blueprint, 74 
Filling images, 72 
Graph Paper, 75 
Index, 71 
Protecting the Footprint, 76 
Rotating & Flipping, 72 

Spacing Tools, 30 
Status bar, 48 
Stripe fabrics, 64 
Studio versions 

Differences between versions, 9 
Studio 2.0, 9 
Studio Design, 10 
Studio Design Suite, 10 
Studio Lite, 9 
Studio Modules, 10 
Studio Planner, 9 

System Requirements, 3 

T 

Table, creating, 25 
Tabs, page, 43 
Tech Support 

Contact us, 83 
Forum, 77 
Learning CD’s, 83 
Tutorial, 82 
Webinars, 83 

Text box, creating, 24 
The Lounge, 77 
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Toolbars 
Bottom, 26 
Side, 17 
Top, 11 

Transparency, 16 
Trim 

Adding, 52 
Create a layer for, 13 
Duplicating, 52 
Skewing, 51 
Spacing, 52 
Stacking order, 52 

Tutorial, 82 

U 

Ungroup an image, 27 
Unlock an image, 28 
Unprotecting a photograph from selection, 70 

W 

Wall size, edit, 43 
Wall Templates, 45 
Webinars, 83 
Workspace, 8 

Z 

Zoom, 14, 52 
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